(ML) KK LN

—. XFARSZIIKHNAEIZER

1. RIEEFR: AL

2. BREABRAREME: NHEARZGHEILN HE AR A=

3. EAEN. B WA LN AR

4. 26, MB#=: 8240, 8 H

5. Lh&&E

(1) FEi PCHL—E, k2% windows #:/E R4, VC IF & T HA OFFICE 1. H;

(2) %% QuickTest 1 WinRunner [ 25 T M.

6. SEilltthes: B TRESLIE
—. il B&Y:

CEAFMARY 2P TR R 2R =20, ARSI S CRAINRAE AR ) #ig
R I, HAfEiurty, Wit MeEGIseEs . AL IRFEEE IR T2 5 N 1 45
fry FEEFEEAE RN S bRsh Tae 0, S omEct TR H i RN . s
W, A R PR EREOR,  Ffagis BN T 24T B 34k
=. LiMESMELREX:

ARSI TR AR SR A A SE OE M 1) EALSE S, IS AR (R SEEG R o B A A T
ITER, SR ETIE— B, B0 UE T H A 25 AR R R AR TR vk Bt H i 2
AP RAF MR AT TSR A v, IR e ). 56 T8 HE T A 2e A
SIMTIRNEL, R IEE T, B R CREDH I RE ) A B RE
M. SEYIHER 4

g Sl E LR AT STl b #iE
L | gl B A0 e ik T H 3 AT TR =

2| Dhietk it 3 AT TR =

3 | G PER 3 AT TR =

4| ek 3 AT TR =

5 | QuickTest Professional #]2% 1 i 3 AF TR =

6 | QuickTest Professional %1% H] 3 A TR S

7| WinRunner 45 1] 4 WA T RS =

8 | Web R4t 4 BAF TR =

F. EZME BRRAR. . A IFS R

TR BT A LML Bihg. BOR=TTHERe %1%, BARERGhRE & L] W ke
MRS bR tER

. D%
o R [ % [#n

H 2 51 4| 3 2

AE 2 5| 4| 3 2

TR 5| 4| 3 2

IR 20 | 16 | 13 | 10

Fifig elERE 15 12 |10 | 7

Iy Wik i) BiGE S | 20 | 16 | 13 | 10

e FEIN 58 3G O 10| 8 | 7 5




| | ek [20]16 13 ] 10 | |

CEREME) TINESH

—. REEZM: HmEML
—. RREERRARHEME: NMARAKZRITENERRABAE
=, @EAEN: REIEMEAAR
M. sLillZEt: 10 ZE
. XWigE
(L T PCHL—F, ZR2e%: windows #:/E &% VC IT K T HFI OFFICE T.H,;
(2) 2% QuickTest A1 WinRunner [15h3a8 T H..
7~ Kl B SR FRHE R EE A5
FEFEIMM NS Hife. ROER = EEG %%, BARSGHRAE S La) WL T 5k
WG FRiER -

DS AN FE ﬁk,y—l
PP FER TTE T T 3 oy
HER 5 4 3 2
&IE 2 5 4 3 2
TR 5 4 3 2
LR 20 | 16 | 13 | 10
Hifg PRERE ) 15 | 12 | 10 7
Iy MR EaE S | 20 | 16 | 13 | 10
M FEI 56 B Dl 10 | 8 7 5
AR SR 20 | 16 | 13 | 10

+. MR REIR

1. AR

i’ﬂ#iﬂﬂiﬁ?ﬁt%ﬁi’ﬂ*&)\ﬁﬁﬁﬁ, XPRAE T K A3 M VT T RUAS 150 BH R G B (1) e 28 2
ST A R R UE R S A BAFMAE R T ORI R AT R P R B i, &
4300 ﬁﬁm*ﬁﬁiﬁﬁﬂﬁ%ﬁﬁﬁxmﬂ%%%%D?T‘EJ?EI’JV\]*B ARG Lo e U — LI A 1 CRJY
o NEHE LT s g5 Y, IR R X S i s AT R, DUR IR R R i i
Fi.

2. MR FE

H T ARAERA I e, R R A O LAY B, B AR A B, AR R

v RGN I

A4 B — 2 NGBR3 iﬁ/ﬁn%ﬁ(xﬁzﬁ%ﬁﬁ ﬁ?‘i" W‘ﬁ OpUR

F IR A A A A R BT R B /N LA SRR IR S R AR 1) 5
BrRINRE & SOZAER I Th e B AT A 1S O, U\&fﬁﬁ%ﬁ HiR,

A IR o AR 2 FR R 1 R AL Ok [ N AT, FEHARE RIS X
(1) ) 8

RGEMAREMIRIEAN RS, DAESCEie “ TR U7 Frile fIhee. Al
PR A TH AR

IOCINRR I H 2 ) AR 1 P 3R W R G RENS 15 P e ERASAE T AE . 5 R
AL, E MR N AN, BB i B P AT

3. WA v

AR 51893 8 DR P MR A 25 b 1 D

IREMRR e AE X B R T Ih e e 0 3kmt b, B R R Ih e soc, ARG e




g e, X REANThRE HL oA A B AT R . BEAT DO REDIRI, B AE P 4 Y
VESTANTFI S &, BRI JCiE: T AR Sy ket , DRI SORR A PR St
SERI PRI I8 7= o S AR LR, ARG = i P S B A A 5 e RIS 18 B 15 1 2

E%ﬁﬁ B ARVFIRAN A R W A g5 1) S A5 B, ek B B ],
SRR T S RTINS VAR BB/ E AN E T, X A&,

4. M TH

AP TAE SRR K (FEgett, I3 40% [T R a]; — e n] Sk Bk AR5
(AR A, IR IS ) 2 3R T 2 IS 1] ) 60% ), RN 5 2 7 AN i Rt b A ] g
F%ﬁﬁﬂﬁﬁﬁﬂ%%IW,FIm@ﬁ%ﬁ%%WﬁEE@m B I BlErEr . &
SRANEER S0 TAE . WRR T H AN Sl 78 1. MR T H— 8o F &
TR T H BENRA T MERENRA T H, S/hEA TR CR R R o 2
BEAEREAE B, MR B D 1T,

A SIS T 2 2 & 3] QuickTest Professional #11 WinRunner [ 214k T ..

5. M B9 5

(1). MR

BRI A T T IR ) A 250 o — AL R 5 o 03 481 g St — Ak
M0 B RGN E . B ol PR B

AR B % A FEA I N A T N FN TR, BN SERR A AP Jrde (el
TR BIIAT BT L A7AE PRI ) R BRI V2 AR TR A S B N o SO 4 A 2
Ja RSB o MRS B E T A R A, BRI BN . I . RS
B edr U B T LR, DU iz E Rl . TR R A A A 4 ) S A
(R O FESCRRMNRE R, MO TRk k. PPa . L S EAIRAT .

& 1-1 Dl
A1 1D

H i

Hij$2

LI

T 33y i

IEES

AT AL

H gk PATA

AT P RRSEAT 0 n] AR B IR 9], B S e IR 4544 PRI
NRENEM R FEAI T, AEATRE P A R AT A A2 R A2 SIS S 21 i L R 1
PRAL P WA TR ], R REE LR R RIThREME iR R I 61,
PITASE P A ME {5 St A2 A AR Ui o ZhEEPENN GRS B s (1) Thig
PERA S AT s BLIE O, B AR SCBLUA AR A4, MRS RA T (2) I
TR VLS SCBLIFATREAT, DRI T4 R BT RN 1) o AR BRI, D REMEIIH] ] th e
FOH ORI A DL BT B T REAFAE ™ EERTUA, AN R BEIE AT RN A . 2D
REPEMR I BRI iR 2T Aty AR BIATE DL RRREINA.
ASET IS Ay S SREE T RS
SR PN AT IS Y IR AR PRI AE A R AR R, R IR A
W%ﬂ%% f%ﬂ%%%%MHEE%ﬁﬁ SR VNN T S A T AR AL A B



AR XTSRRI AP TEIIGURE S5 28 AR, I 0 SRS R B o R
SR PEI I EE T AT A N BRI AE RIS A

AESEBR I R O At (IR s ABORS G5 AR P DR S e D 25 15 e R A
e
(2) BAFHBER
A 2PN AT LI 7238 DU DU R 1R IR T A B BOR K 70+ AR N 2R 280™ A 1
JE SRR« DU ORI 7« AR PR 257 AR 1K KU R ) 702555 . A L IR AT
DaCrbr, TR 20 R B S AR e B Je SR (™ RE BEORHEA TR 70, AR 2 oo AE 5K B
IO PR ) AR FL A 0o ™ SRR PR 70 AN R R S5 20

(3) MR )k +

PN 1 BRI D3 e T AR 5%, AN IR Vg n] g S0l R i Kk
RN, BRI H bR AR

M ERESEZER A A EE U, DI BT JL A S AHE D -

(L MR AL BERS AR S TG BN G B . SERRERER . 25
BT, AL AR PR A AR . R AT PA S R 4

(2) WAL R A AE T BRI T 45 AL IR I A2 n] AL B sl PPAG ) 5

(3) ARGE ARy FRUE: RIS RIRE A 9], 2R e A HRA T 45 RN 2 AT TR Y

® 1-2 ik R

s | AR 24

1 LR TS B R

2 g RPRELHR

3 A AR A4 7K

4 AL A7 L8R oy AT A B

5 U LR

6 AR AN IERR AT 5 Ak B

7 e 200 AR ™ R
8 ToiE % Kol ERA

9 FKAEVE ARG

10 T PRI R G R AT




Kill— XA IR FIR TN TR

[3<32 B RY]

LSRG, BRI Rt

2. BB Junit HERLIEATHE T java i 25 10 2T K
[SR362K]

1. A A SRR BT ok T R e Bk 491«

FEFPEIR: 10 M ER A —AMEER (A ERIE R ), R =R R ER.

FEFP B SR — IR R IR 5 ANER, JIRTAR I — 10 ek SRR 5ANEk, Bk
AN RFR, WA 2 AN ER: WA, R R B Bk AR E, EHERHA
BRFRES =R, BRI I ER.

20 AE AN AR AR BT T 451

BN = ANRAE i, I RS SR = AL = A
[REABSERTE]

1. AEFH A SRR BT ik T R e B 491«

(L W

package P1,;

public class SearchBall {
private static int x[]=new int[ 10];
public SearchBall(){}
public void setBWei ght(int w[]){
for(int i=0;i<w.length;i++){
X[i]=w[i];

}
public String BeginSearch(){
F(X[O] +x{ 1] +x[ 2] +X[3] +x[ 4] <X[ 5] +x[ 6] +X[ 7] +X[8] +X[9])

if(x[1]+x[2]==x[ 3] +x[4])
{

System.out.printin("1 5 & i Ek");
return "1 5 R ER":

}
if(x[1]+x[ 2] <x[3]+x[4])
{

if (x[1]<x[2])

{

System.out.println("2 5 &R EK");
return "2 R RER";

}

else

{
System.out.println("3 5 & REK");

return "3 SR K"
}

}

else
if (X[3]<x[4])
{

System.out.println("4 5 &K EK");
return "4 S 2R BR"



}

else

{
System.out.println("5 5 JE B ER™);
return "5 52 ERER",
}
}
}
else
If(x[6]+X[ 7]==x[8] +X[9])
{

System.out.println("6 5 &K EK");
return "6 ‘52 R EK";

}
If(x[6] +x[ 7]<x[8]+X[9])
if (X[6]<xX[7])

{

System.out.printin("7 5 J& i Ek");
return "7 5 2R ER":

}

else

{
System.out.printn("8 5 & Ek");
return "8 5 R ER":

}
}
else
if ([8]<X[9])
{
System.out.printin("9 5 JE B Ek™);
return "9 5 &R ER";
}
else
{
System.out.println("10 5 & 5 3K");
return "10 5 & Rk
}
}
}

}
public static void main (String argd[]){
SearchBall sb=new SearchBall();

int a0[]1={1,2,2,2,2,2,2,2,2,2};

int al[]={2,1,2,2,2,2,2,2,2,2};

int a2[]={2,2,1,2,2,2,2,2,2,2};

int a3[]={2,2,2,1,2,2,2,2,2,2};

int a4{]={2,2,2,2,1,2,2,2,2,2};

int a5[]={2,2,2,2,2,1,2,2,2,2};

int 86[]1={2,2,2,2,2,2,1,2,2,2};

int a7[1={2,2,2,2,2,2,2,1,2,2};

int a8[]1={2,2,2,2,2,2,2,2,1,2};

int 89[]1={2,2,2,2,2,2,2,2,2,1};
sh.setBWeight(a0);
System.out.printin(sb.BeginSearch());



sh.setBWeight(al);
System.out.printin(sb.BeginSearch());
sh.setBWeight(a2);
System.out.printin(sb.BeginSearch());
sh.setBWeight(a3);
System.out.printin(sb.BeginSearch());
sh.setBWeight(a4);
System.out.printin(sb.BeginSearch());
sh.setBWeight(ab);
System.out.printin(sb.BeginSearch());
sh.setBWeight(a6);
System.out.printin(sb.BeginSearch());
sh.setBWeight(a?);
System.out.printin(sb.BeginSearch());
sh.setBWei ght(a8);
System.out.printin(sb.BeginSearch());
sh.setBWeight(29);
System.out.printin(sb.BeginSearch());
}

}
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package P1,;

import junit.framework.TestCase;

public class SearchBall Test extends TestCase {

int 20[]={1,2,2.2,2,2,2,2,2,2}
intal[]={2,1,2,2,2,2,2,2,2,2}
inta2[]={2,2,1,2,2,2,2,2,2,2}
int a3[]={2,2,2,1,2.2,2,2,2,2}
int ad[]={2,2,2,2,1,2,2,2,2,2}
int a5[]={2,2,2,2,2,1,2,2,2,2} ;
int a6[]={2,2,2,2,2,2,1,2,2,2}
inta7[]={2,2.2,2,2.2,2,1,2,2}
int a8[]={2,2,2,2,2,2,2,2,1,2} ;
int a9[]={2,2,2,2,2,2,2,2,2,1};

public void testBeginSearch() {

SearchBall SB=new SearchBall();

SB.setBWeight(a0);
assertEquals("1 5 JE BEk",
SB.setBWeight(al);
assertEquals("2 5 JE BEK",
SB.setBWeight(a2);
assertEqual ("3 5 & flRER",
SB.setBWeight(a3);
assertEquals("4 5 JE BEKR",
SB.setBWeight(a4);
assertEquals("5 5 J& BEKR",
SB.setBWeight(a5);
assertEqual ("6 5 & flRER",
SB.setBWeight(a6);
assertEquals("7 5 JE BEKR",
SB.setBWeight(a?);
assertEqual ("8 5 J& BEK",
SB.setBWeight(a8);
assertEquals("9 5 J& BEK",
SB.setBWeight(a9);

assertEqual s("10 5 R Bk

}

SB.BeginSearch());
SB.BeginSearch());
SB.BeginSearch());
SB.BeginSearch());
SB.BeginSearch());
SB.BeginSearch());
SB.BeginSearch());
SB.BeginSearch());
SB.BeginSearch());

',.SB.BeginSearch());

public static void main(String argd[]) {
junit.textui. TestRunner.run(SearchBall Test.cl ass);

}
}
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package p1;
import java.io.*;
public class JTriangle {
privateint b,c,a;
private static int x1,x2,x3;
private static String s1,s2,s3;
public void setA(int a){
this.a=a; }
public void setB(int b){
this.b=b;}
public void setC(int c){
this.c=c; }
public boolean IsTriangle(){
if(atb>c& & atc>h& & b+c>a& & al=0& & b!=0& & c!=0)
return true;
else

}
public JTriangl&(){

return false;

}
public JTriangle(int _ajint _b,int _c){

setA(_a);
setB(_b);
setC(_c);

public String JudgeTriangle()

if(IsTriangle())

if(e==b& & a==c)
{
return "510 = 2"

}

else if(a==b||b==c||a==c){
return "S5 = 1 B

}

else

{
}

return "— K = JE";
else
return "ANRELL R = AR BT,
public boolean ISNumble(String s)
if(s.length()==0){
return false;
char ch[]=s.toCharArray();

for(int i=0;i<ch.length;i++)
{



if(ch[i]>='0&&ch[i]<="9")

continue;
ese
return false
}
return true;
}
}
public void SetTriangle(){
try

{

BufferedReader in=new BufferedReader(new InputStreamReader (System.in));
System.out.printin("iE A = A TEH —=i8: ");

System.out.println("a=");

sl=in.readLine();

while(! SNumble(sl)){
System.out.printin(" /R A A EAS BT,
System.out.printin("a=");
sl=in.readLine();

System.out.printin("b=");
s2=in.readLine();
while(! SNumble&(s2)){
System.out.printin(" /R A AN A BT,
System.out.printin("b=");
s2=in.readLine();
}
System.out.printin("c=");
s3=in.readLine();
while(! SNumble(s3)){
System.out.printin(" /R i A AN AN BT,
System.out.printin("C=");

s3=in.readLine();
}
catch(IOException €)
{}

x1=Integer.parsel nt(sl);
x2=I nteger.parsel nt(s2);
x3=I nteger.parsel nt(s3);

setA(x1);
setB(x2);
setC(x3);

public static void main(String argg[])
{ JTriangle tr=new JTriangl&();
tr.SetTriangle();
System.out.print(tr.JudgeTriangle()) ;

}
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package p1;

import junit.framework.TestCase;

public class JTriangleTest extends TestCase {

JTriangletr;

public void testJudgeTriangle() {




tr=new JTriangle(0,1,2);
assertEqual (" AN e 41k — ff1 J2 " tr.JudgeTriangle());
tr=new JTriangle(1,0,2);
assertEqual (" AN e 41— ff1 T2 tr.JudgeTriangle());
tr=new JTriangle(1,2,0);
assertEqual (" AN e 41— ff1 T2 tr.JudgeTriangle());

tr=new JTriangle(1,2,3);
assertEqual (" AN BE 41— ff1 T2 tr.JudgeTriangle());
tr=new JTriangle(1,3,2);
assertEqual (" AN e 41k — ff1 J2 " tr.JudgeTriangle());
tr=new JTriangle(3,1,2);
assertEqual (" AN e 41— ff1 T2 tr.JudgeTriangle());

tr=new JTriangle(3,4,5);
assertEqual (" — & = #fi )" tr.JudgeTriangle());

tr=new JTriangle(3,3,4);
assertEqual (55 I — 1 JE" tr.JudgeTriangl &());
tr=new JTriangle(3,4,3);
assertEqual s(" 5515 — A £ tr.JudgeTriangl &());
tr=new JTriangle(4,3,3);
assertEqual s("55 15 — ff J£" tr.JudgeTriangl &());

tr=new JTriangle(3,3,3);
assertEqual ("534 = £ £ tr.JudgeTriangl());
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if aORbD
then procedure x
else procedure y;
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1. BH—: FHZEERNEATTEIAU TRERFBR

void DoWork (int x,int y,int 2)

{
int k=0, j=0;
if ((x>3)&&(z<10))
{

k=x*y-1;
j=sart(k);
}
if(x==4)lI(y>5))
j=x*y+10;
j=1%3;
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}
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Hahdlidk. WUERERBOH A TAT N . fH] QuickTest Professional JCHE 4Kl A 230k

(Auto-documentation) F1i% 5% (Active Screen), JCi—ATAE, wlhnl LLEIERME e R AT, A
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QuickTest 1% NS AL
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u Filetoolbar: & HR A M T 2%, Filetoolbar 414 5-2 fi/w.
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New Save Active Debug Test Quality  Object
Screen Viewer Settings Center  Spy
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%] 5-2File toolbar
u  Testtoolbar: S&HHINAMA R FA T E%1. Test toolbar 41l 5-3 fias.

Split Start Analog
Record Stop Action  Transaction Recording

Start New  Insert End Low-Level
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| 5-3 Test toolbar
u  Debugtoolbar: X MK IARRE H H 1 T H%. Debug toolbar 41l 5-4 7.
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Into  Out Breakpoints
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%] 5-4 Debug toolbar
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T AE AR FLAEAS DU A o 30 4

Test pane: B 7 Keyword View L Expert View.
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1. BHE—: WA MercuryTours M ¥k
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A IE 3T 45 3
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PR . ARG AT DA I E 2 B &5
[T %]
—. SKHIE AR
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2. MIE I ANGERY i LAshserk) %48, Ja Lashse ke ] XFils .
316 U TEshser )Y BeH Uik i AR A& ] Em. .
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= HIEA

Sl — N A . £E Mercury Tours JE41 W vl _ETAT —3k MA1Z5 (New York) FIH 41l
(San Francisco) FIHL2E,
1. AT QuickTest F£IT JH —A~ 28 IR A
FIF 3 QuickTest, i Aiik L1465 1> #2742 1> QuickTest Professional 1>[ QuickTest Professional 1.
7t [Add-in Manager] 2%t [WebAdd-in), JFHGHIE M add-ins. #R)5 riik [OK] 4 5%
[Add-in Manager] 7 I, X\ QuickTest Professional 1% .
fan i3l [Wecome] % 11, 5k [Blank Test]. 2i#, sk [Fle]l > [New), oidi F T 251
f) [New]) $%41. QuickTest Professional 2T 3 48 MR IEIA RS 2. i 1 QuickTest Professional &
29153, K7 [Hepl > [ About Quick Test Professional 1 & H i ik T Wkt add-ins .
2. JFUR SR A
sk [Test] > [Record] 50g sk T H %1 ¥ [Record] #%4. 43713 [ Record and Run
Settings] X[ UG % 1. 76 [Web] 1145, A% [ Open the following browser when arecord or run
sessionbegins). M [Typel T Huig k%46 I Hgd % as, JF HAE [Address] %A
http://newtours.mercuryinteractive.com.
i5Hf. [ Do not record and run on browsersthat are aready open] 5 [ Close the browser
when the test is closed] iX —ANIEIAS A1 T, Wil 5-5 Fis.

Record and Run Settings

Microsoft Intemet Explorer - |
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v
v

| 5-5 Web 1t 1
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7t [WindowsApplications] 7145, “2Ji% [Record and run on these app (opened on session start)], i
HABLERATAT I SRR e e w] DU G s il B e AR Cln Outlook) [ #1E. n] 5-6 i
TRo

Record and Run Settings

K| 5-6 Windows Application 17

Ak [OKY. QuickTest £ FF i 3t i #% 31 ¥4 Mercury Tours P3iti, I HLIF4E 53 MR A

# N\ Mercury Tours Web site (M3, F [User Name] &5 [ Password] i A 244013 it K 5 15 260
Ak [Sign-In), JF)3 [Flight Finder] M. #2280, 8 KHLUIHE . 2% [CONTINUE] %
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i [BACK TOHOME] [1]F] Mercury Tours ¥ 3 () 15 1T .
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f QuickTest, sk THAH i) [Sop] #&4l, {5 1bsgthil. BLOA5emk T e [AHA- 1040 ] Pl
M5 1E, QuickTest L4 T MI% I [Record) %415, FH% N [Stop) $%412 18] i3 4k .

4. AR A

EH [File]> [ Savel s/ s ik T H 51 L [ Save) #%4l, T [ Savel 56 % o 37—~ [ Tutorial ]
Hak, BIRRIEA 4 % [Recording). /A% [ SaveActive Screen files].
YR ALY #2241, A4 FK (Recording) 43 tHHIAE QuickTest 7l F KI5 1),
=. 7T Keyword View KU A R4

SRR MIAS N, QuickTest 23K fF— MAE B R, IF4E Keyword View 2518l Excel TAER 77
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A e ) A — AN D ERAE Keyword View H# 43 LL—F1R o, Hrp a8 RISk R /s b4l AR 800 ( El
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: 9] Signdn Du:l: 2 2 ;Elr.'k the "Sigr-n" image.
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qr_“ Welsoms: Msrcury Tours !S}Hw ‘it For the \Wab page o conchronize belaie contruirg the run.
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K 2 Bk A A AT DAAE S A R B SR 2 RS B

2. BN

A 53 H 11 “Book a Flight T s s RS £ A

A SR B0 e 4 T A A

AT QuickTest Jf-JF i3 [ Recording MEAMIAS . 4 75 47 4 “Checkpoint”.

R B ) TS AR A 25 AR Ui . SIS B, DMEYETRE I A T A B “First Name g 4R HE )5 ,
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Object Selection - Checkpoint Properties

58 WebTable : Home
=] -E_ﬂ WwiebTable : SIGN-OFF .
=-5H WebTable : Please review your travel itinerary and m

Elﬂﬁ ‘WebTable : Please review your travel itinerary a1
=-5H webTable : Summary
=-§H WebTable : First Name:

K 61 Rk HE— i m
A % H fi R “WebEdit: passHrst0”, ARJ5 i “ifise™. KT IT R s P whe,
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| % Checkpoint Properties

K 6-2 i E
PO IE A L2 B R g [name) X MR INAHE  [Class] 21X A% 420 . WebEdit
FOREAR G2 editbox. 7E [Typel 7BUH 1) [ABCY BAREZRIXA g ML B2
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1t Keyword View ', JEJT(+) [Action1] > ["Welcome: Mercury Tours").  #£H{ Keyword View )
[ 'Book aFlight: Mercury"] M. 7& [Active Screen] £ 7RI AN W T 41 1

7t [Active Screen] AT =My 4% T EARAT 8, KEHC [nsert Standard Checkpoint], 27T
[ Object Sdlection — Checkpoint Properties] %1% % 1, WK 6-3 fion. BT R mIERIA BEAR, WG H
PR 7R B E B IR ST e s A —HE .

| Object Selection - Checkpoint Properties

= §H WebT able : Home
=58 WebTable : SIGN-OFF

= -Eﬂ WebTable : Please review your travel itinerary and make
=158 WebTable : Please review your travel itinerary and
&8 WebT able : Summary

Kl 6-3 X Rk HE-f A nlE M

#ii% [ Page: Book aFlight: Mercury] (fE# LJE) AR5 83k [OK]). #EFHTT)H
[ Page Checkpoint Properties] XJifi i 1. 4HATMIART, QuickTest 2 i W Ui ¥ 1% 45 5 A it 40
PLR AR ] QuickTest t R EAF4 link ) URL LLRBEAN B F 1SS 0f SCPF R 5 A7 AT .

P2 BRUME, ik [OK]. QuickTest £37F Book aFlight: Mercury [ 5T J5 i —AN R 4G 7

sk [Fle]l > [Save] s ik TR B [Savel 3% H1 R AF M4

4. EXE

TEMCE N — N AR A 5, K tr7E ["Rlight Confirmation®Y W 7 & 75 Hi30 ["New York"] .

1t Keyword View #1, fEJF(+) [Action1] > ["Welcome: Mercury Tours'] . %1 Keyword View
i) ["Flight Confirmation: Mercury"] M, 7£ [Active Screen] £ {71 % BT 1) i [

7t [Active Screen] ', JEHUTE [Departing,] N7 [New York] o XFZEHISC74% T BlbnA B,
Rk [insert Text Checkpoint] JF i3 [ Text Checkpoint Properties] XJifi % 1, 1K 4-12 iR

1 [Checked Text] HILAE FHr i sy, 76 [Constant] 7Bt 4 /R MINBE I ) 7. e
QuickTest 7 AT MR A I B BEAG A (19307 e FOK Y SGHXEE . Quick Test 23 7E M EIAS -
b= SCFR A AT, XA ST A A HIAE [MFlight Confirmation: Mercury" 1 B 0T~ 5.

sk [Fle]l > [Save] s ik TR B [Savel 32 H1 R AE M A

5. MAFRKE

AN EREA N, K7 [Book aFlight: Mercury Y I’ 0T L Hi [ AT HE 4%

1t Keyword View #1, JEJF(+) [Action1] > ["Welcome: Mercury Tours'] . %1 Keyword View
(") ["Book aFlight: Mercury"] M 1l. 7& [Active Screen] 2% %7 I 0T [ i i o
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Kl 6-4 SUAK T s 1

7 [Active Screen] H, £E4—MIFEH# £ L (New York to San Francisco) —270— sk il brds
i, SRJEIEE [nsert Standard Checkpoint] . 23 7f )i [ Object Selection — Checkpoint Properties] % i %
M,

— IR LI 7 WebElement: 270, IX N2k b — 1) WebTable X%, £l Web Table:
New Y ork to San Fransisco.

TR, X ERE [ActiveScreen] |, JEIUH RIS PAER K. ik [OK] .

45 FF )5 [ Table Checkpoint Properties] i & 11, 5 s k& (1 A 25

TR R T Bl e i , SRR F B o R T o AR DA B, R i 7 B,
BUREHCEAFE B, PATEIEE B

TERASFBIARES 0 =, DO AR ER, SRIGTESE 34T 28 3Fm N, &7E 270 e it
AR R, AT QuickTest 23 %) it 7 B A Aok 2

UL LOKY KPIX 1 % o QuickTest 7EMA A, ["Book aFlight: Mercury"] Tif i I
— R R

sk [Rle] > [Savel sl ik THA L) [ Savel 441 CRA7F MR A o

6. f FARAE RIBAT H TR

A B R AW, AT, IR A s R

1) BIFHEFRWR.

HePe LI > 2P e T s Al B AL B DG . I s OB RLIE] 5 18] 6-5 AL,



7 Action]
- ﬁWelcomB Mercurm Tours
v &2 Welcome: Mercury Tours | !
: B ysert ame Set E"rrter-::t.tr:."' Enter "mercury” in the "uzerlame" edit box,

i * password SetSecure: "4082386633 Enter the enciypted stiing 4082985239546 37(
: 5 Signn | Click, 122 | Click the "Sign-n" image.
orj Find a Flight Mercury
- 5= fromPort :Select "NewYork"  Select item "Mew York™ in the "fromPort” bist.
: r frormManth Select ;"Dec" ;Select item "Dec" in the "fromMonth' list
&2 fomDay Select  "29" Select ftem 29" in the "fromDiay” st

- 12 toPort Select  "San Francisc . Select item "San Francisco™ in the “toPort” list
&= toMonth {Select  |"Dec” ;Select item "Diec in the "'toManth" list,
“ 5 toDay Select 31" ‘Select item "31"in the "toDay' list
o8 serClass Select g"Business" ‘Select radio button "Business" in the "servClass"
5 findFlights :I:Hck 2.2 Clrck the "findFhghts" image.
.,rj Select a Flight: Mercury
: E reserveFlights []ic:k 122 Clﬁ:k the “reserveflights" image.

Page checkpoint ——v—a Book a Flight: Mercury :Eheck ;CheckPoint["... ;Check whether the "Book a Flight: Mercuy'" \Web
Table checkpome———-—“a Mew York to SanFr.,, Check CheckPaint]".. Check whether the content of specified cells in th

! ‘ paszsFirstD :Set "Micole” :Enter "Nicole” in the “passFirst]" edit box.
Standard —— € pacsFirst0 [Check  |CheckPaint{".. |Check whether the "passFirst0’" edit box has the ¢
checkpoint e B¥ passLast0 ‘Set “Jones™ Enter "Jones” in the "passLast])"” edit box.

: F creditnumber Set :12345" (Enter '"12345" in the "creditnumber” edit box.

o7 licketLess Set l"oN" :Sel the: state of the "ticketLess" check box to "0t
5 buyFlights iChck 22 Click the "buyFlights” image.

Text checkpoint ——v—ﬁ Flight Confirmation: Mer.. Check i CheckPoint[".. : Check whether test in the "Fhght Confirmation: Me

f Lo 9] home Cick | | Click the "home" image.

----- o3 Welcome: Mercury Tours | Sync wai for the Web page to synchionize before conl

K 6-5 Jt AL

2) FFRIBATIR
s AT R R WSS AT o BT I ABAT X IERE o TR DR B s AT R e

CRNNINESE SR L S S i v Tl VR e #ill e e W P2 A R R S A R
3) ARWALR.

) QuickTest 5¢ MAa AT MBAIN, REFTIFMNRGT R B 1o ST RV 2N T, RoRPri i &

SO WER A B A UK WIS R <R
4) ARREMAERKSR.

TSR, il (+) J#JT“Checkpoint Iteration 1 (Row 1)”> “Actionl Summary”> “Welcome:
Mercury Tours’>“Book a Flight: Mercury”. 58 H 7“7 55" Book a Flight: Mercury”.
FECVEANE BB th At T O SR IH , w] DL A DUk 2 s PR 045 .

R Ol R, PR CA A A S B S B UM (B A DL .
5 ARRMERKELER,

ESE BB “Book aFlight: 7t I, il (+) JEJF“New York to San Francisco”. 58 H 7R 25 i1
"New York to San Francisco™.
FEVEANE B E A b, AT DAAE R A S TR o 36 n] DUAE R B oH IO (O 5T
7R A R0 RAS A () B TR A s ok K (5
6) BEHERE KKIER.
7545 T ) “Book a Flight: Mercury” T I, ¥y (+) JiJF“passFirst0”.
SR 7R R A i passHrst0”s fE“VEANE B Gtk b AU T O & i@ It Al AT LA B RS

JEgEl E’Jﬁééﬁﬂm Eho
7) BEXARERRIER.



LG RR R, P (+) i JT<Checkpoint Iterationl (Row 1)”> “Actionl
Summary”>“Welcome: Mercury Tours”>“Flight Confirmation: Mercury”. 58t 75K 2 £ New Y ork™.
TE“TEGNAR B Es b, LA SCARK A AU 5 B
8) RHI“WAL R & H .
= SHEHIR

RN RPN, RTREAS SR A i N AR FH 20 2 858 R B AT AR IR R E 1R 7 20 i, AR i
Ao SR i I s e 17 -2 SR s 1) D7 2 8T DSt 0 SR R I, BRI AL B S — 2
B, AT DO AR R SA, AR E AT TR, T RS AT H AT AN R — 450

1. EXBHERSH

57 s R A T T ALY BN IH G L HLEE, AR A, 2 @A 8l ot 2 Ui,
FER AT DR AS T8 WL H b it 0 A AT o A0 oK 2 2 ST An AR B A w1 1 O i 2 5 dk,
Wt —k,  PAT IR AR N 52 AAS [R] 9 H A s BT T .

1) 7T QuickTest JJF i3 [ Checkpoint | il A

2) B UEA S A4 A T Parameter | AT A

3) #fith [Active Screen] & JT )i i)

4) ERESHALI ST

7t Keyword View #, £ JF(+H)[ Action1 I "Welcome: Mercury Tour" J>[ "Find a Flight: Mercury” 1. 7&

Keyword View H x5k " fromPort" 4711 1) [Vauel 7B, RJ5H kS5, Wik 66 fix .

| Value Configuration Options I

. Kl 6-6 2 Hi{E fiil H ik I
=87 Klbr, 23973 [Vaue Configuration Options] X1 & I .

5) WiEESHALIJE

MLIE Parameter. At —3k, HinTLMEFH SEUERIURA L) (New York) XANHHUE . 1HIEHE
[ Data Tabled X ANMEI, X AL FR/R LS EI{E 23 M QuickTest [¥) Data Table i . 1 H. [Name]
TR I p_ltem, R HAZ UK departure. WA 4-15 fToR.

RUELOK I 1 % 1. QuickTest 2371 Data Table 17§14 departure 47 B, I Hifi A—47 New York
IME . JU) New Y ork 23 e A Uk B AR SO T s BT FH ) 28— AMME.
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2. EEHERTMASH

QuickTest 437t Data Table 1" il /s Z4({f . W LAYE DataTable NN B 2 28 kM e iy Wk, ik
QuickTest 1] LA A iX 26 ZERHRAT IR A

1) 7t departure 7 Bt A\ 2 Hds

2) ff AR A

IR S — F1E Keyword View 254k . fES 44k 2 11, SE B0 B8 R [ fromPort” Select
"New York"] o HL7E, XANMMAP AT [fromPort T vure”, DTGlobal Sheef)] .
i H M sk [vauel F-Bi,  [Valuel BB — RIS B2
ZHA T, i H A& M Data Table () departure 7B B

3. BHZSHNEE ST

ZHAGIRR T 3 — DB, 763 S 0 D B A I JLAB I G T RE e 52 B o R AR
XL, B ZHUE SOX EE X G PR AE LAV A S 8 B AL SR B . AEASTR 23, B SO ES
A, DMEZEEAT AT, QuickTest #6755 24wy H & 3 i AR DT IC ) SCAR

1) 587 AL U SO AT A5

EEE Y, i (+) EJF“Wecome:Mercury Tours”.

At i <Right Confirmation:Mercury”, SR 5 16K 2 iR 1R T SOAKS B 5 1% TH A,
Wk 6-8 iR

!7~/ Text Checkpoint Properties

Kl 6-8 SUA & i
2 ZHMNICARE .



FECOARL A SCARIX IR, “New York i /nfE“H E7HEH o “New Y ork” & & — IR IA I 23 0 (1 T
{EO
EESH, RaisHornirmda o BT S EETUREHE, WK 6-9 FiR.

Parameter Options

5-9 Z%{ik Il

E“AFRMER, JEPEdeparture”. 1XHEF5 /A 28 5S A H & e & 1) departure S BB A hy T &5 5L .
BT 8 IR P S HOE TR HE, AR5 PR i e OGP SO 21 m @ M S AE . BRI A
MBS

3) AR

4. BATIHSTERSE AL R

PATE SR E I [ Parameter | IR JIEIA, QuickTest 2314 ] Data Table 1 departure 7 BXfIME, 4
AT = IR AR o

B Poromectcr [Resl] - Tost Reswlts

(=

Tasr Faramers) SUVRary ]
: Ekun-‘l‘hanata Text Checkpoint "New York":
Parameter Ieration 1 (Row 1)
;[b Parameter [teration £ (Row 2) Pas sed
w- M Stertup Browser Date and Time: 4/19/2004-14 4409
-3¢ @ Action1 Sumreary
= x‘ Welcome: Marcury Towrs -
4 welceme: Marcury Tours Details

a Find & Flght: Mercury 2
S Text Checkpoint: coptured *Porlland® between
I Select a Flight: Maraury Deparning snd to San Francisco 12f

- s,{_‘[ Book a Flight: Mercury Metch case: OFF
i Exactmstch OFF
lgnore spaces ON

HI *harme": Jick
- &) Welceme: Marcury Tours Hight Confirmation & 2004 04 - 19311965
3¢ [ 1@ Pararmeter Itaration 3 (low 3) Departing
Portland 10 San Francisco
12/29/2004 @ 5:03 w' Blee Skies Airlines 560

P 6-10 ik 45 F



1) $47 [ Parameter | 1A
2) Frgriialas i
BIVASE SCASRS: 5 5 AE — R ARIA A L, <345 R B 1 2 sl ) 2 R 2 — A A R
ARG R R I TEE L, WS TR A%
¥ 2: 7E resultstree 1, Ji F(+) [Parameter Iteration 2] > [ Actionl Summary] > [ Welcome
Mercury Tours] > [ Flight Confirmation: Mercury] . %H{ [ Checkpoint:"New York"] . 414 4-18 fiR.
7ERT A R [Details] ks, Wor Portland 2 WU 25 S RN A2 S BRAf, it LA 40 2 i 8
e PR AT LAE BIAE T 7R [Application] Za s, ol i & mi s 2 Portland,
B3R 3 (lteration3) :  7E resultstree , JEFF(+) [ Parameter Iteration 3] > [Action
Summary] > [Welcome Mercury Tours] > [ Flight Confirmation: Mercuryl . EHX
[ Checkpoint:"New York"] .
ek A R [Details] ks, Wor Seattle J Fils 45 A w2 52 bR E, BT DA SO 2 o8 18
e RAT LR IR T 7 [Application] kg, W2 HLER 0 H s /2 Seattle.
RERPATING,  HESCF R 2 RO S5 R 3R 5-1 .

lteration Expected Text Actual Text Result

#1 Mew York MNew York Checkpoint Passed
#2 Portland Portland Checkpoint Passed
#3 Seattle Sealftle Checkpoint Passed

R51 XFRELRARGER

TR BRBFIRPAT I, SCFART A A0 45 Wk 1), (58 IR 58 — IR AT 85 SRAT9 88 A 2R
KRR R RSO, 38 AR A B R LR RO, BRI A RURI . LR RSB IE
R A A il QuickTest H 2 T A AL A UM TIUHAZE R, tnT DUS & IEM B 5240 T

3) KIAMRA L R
[Filig&]

T PCHL—%, ZRZeHE windows #:/E R 4. Quick Test Professional8.2. OFFICE T.H;
[RE]

1. BH—: BIERES

FERT—5E%: (QuickTestProfessional HIZAEH]) H skl BIA T GRS B, BB AN S K
AL A A SO KA. REPATINKIA,  FE o il .

2. BE=: SHMLNR

EFI AT —MSE 5 (QuickTestProfessional #1Z% Al /1) kil A, #E4TZHAL .
[T E]

fE L=, QI IFEAT T, DU & AR R e b sl st AT (K — R A0 B2 A5l LU
HHAT o ASZIGZE SRR b — A SIZ0 A A0 S0 e P i A 2 ) DA R T L 0 R B
7 H AR AR, AT B T8 58 R s s 15 IR R IE AT . iy K NNAVE ) S E0 e @ (1),



A LUK N R P S £ P 22 1 B R AT AR A . AR AR NN BRI

1 KA g RS, SIEPAMER A, R A iz S 8 VA

2. RrASCAS: GEHUCCA, B SO 5

3. KRR W ANERKE, RERTIEE;

4. ZHACIIK: BT S EAL I SOR SN S, AT S EAL K
[SRIEX]

1 SRR, BRI GAN EALIGUD BRATIK P 7

2. AT IR AS



SLill£  WinRunner BY{ER

[3<ill B #9]

T i WinRunner )36t fe, JRUHT L5080 . T % WinRunner USRI e, JF BRI AL
FI WinRunner 547 ] 541 PR TAF
[l R=EE]

WinRunner & — RV 2216 F TR 50 0 B2 15 W AT I DhRE VENNA A ol i | 3lisk, &
Wy, FVESH A EREAE, WinRunner BEE HF A G B I LA ORAR L8 2580 22 A 1 FH RSP AR 2 TR
S TR R A SR8 e B, I HARFR KT T §E38 17

WinRunner FIIIRIEFE 3 ANAN BB B GUI map. A1 . I, TR . EF L
i R RILIVER o

—. 4% GUI map

1 RapidTest Script wizard(BR s I 1A AR i) [ B 24 FH = Fhiin, FF RS R4 GUI X G 1
AR INE] GUI map o A BAAE SR IR PR %, 38k 5 S T B AN G A S N 2 GUI map
e

—. Ak

RIS g AR B ) R 7 B DR IAS o s RIS, FEAR T B A A S, 1) b Ty
AR 25 (Checkpoint). i AR A KA GUI 6F 5, A7 &l (Bitmap) FIEHE 8. 78X ANt e, WR
TP, IEER ISR (BRI A RN fAE T K

= ARIRK

AL AE R (Debug mode) FIEATIEIA . ] LLBEE Pk s (Breakpoint), WENAR R, fadhl
WR U FIBG 54 15 . PR 45 Rk IR A7 7 Debug folder, — ELIZE Bt nT AR o

M. $ATIR

FERT R B (Verify mode) TR M A F . WR ZEBIAIZAT Ol B A 205, a4t 22 wir 2500 R 5
TR PRI T LU . R RINAE AT A, Sk B RAE Sl 45 8

fi. BEURER

DUAR A SR I AL R R URKANE o BERIIAAEE SR, WR St 4h B BRAEAS b #0s & 1PER MAT
TR R AT E B, WA, HRER. RAEBRHFER.

W RAER A A AR R, W LLLE Test Results IS ) %l 11 A T 45 AN 92 45 51
WG EIAREE, ] LA T S0 PO (RN Sl 25 SR 2 R) 22 S (Ao 1]

2 S AR R R 7 3 R IE AT R, TT L B2 A Test Results % IR 25 47 JCE IR K15 2
IXEfE EGE R EMAIL KIXZ AL (QA Manager), FIKIRERIX AN R T B 15 H
[SERE]

1. BH—: WA MercuryTours M3k

i F WinRunner %J Hight Reservation Ju {5l F2 P AT DhREMNR . ZERE BTN K e8Il 72, AR5
PAT WA I3 s A

2. BEZ: W& Windows W HRERF

HEFE—A> Windows B R . SRkl b R PR A, SRS AT IR A I E 23T 45 5

3. HE=: WX 163 Mk

i 1 QuickTest X} MercuryTours W 5l HEAT D REMR . 2R S HIFTTF 163 e 2 SR [ 152 34 A1 A g



iAo ARG AT MR A I 2347 45 R
ENEZ
—. WinRunner 1 F ik

1. J33h WinRunner

MU= F>WinRunner>WinRunner %) WR. WR [#] Record/Run Engine(ic s /#0 47 5 14 ) /&
b BLAE Windows (AT 454 Lo IX A5 3BT RI4EY WR R E 2 I fiER: . 56— a5 WR
S BIAE 1, pRn] PUERSHT @I, 77 F CAT WA PR i WR. W RAA 2R )3 30 BiXAS
%1, 7] LU Show on startup i I f/2) 25 i .

2. WinRunner & H

WinRunner F= % I 7-1 froc . % FHE LR

a). WinRunner title bar A5 f3 F

b). Menu bar 3z L

0). Standard toolbar Ar#fE T FL A%, AEIE 1T 5 H 1 dy 2

d). User toolbar Fi 7+ T 542, A5 G gl e & H i iy &

e). Status bar JRAF

WinRunnertite bar
Menu bar

Standard toolbar

X Flight Easervatios
met_wissdow ("Flight Pessrvation”™, 1

penu_smlect_itewn |“Anslysia; Cempha.. .

& Sraph
LEE (“Craph®; Bll, 332))
Bat_ wlbdow("Graph®, 13)
ob]_get_text |"G3_Trawiog™, text, 253,

win_clome (™Ermph®|;

X Flrght Raservalicx
per_wiedow (*Flight Besecvaricn®, 9|)
renu_seleot_itew |"Filegfew Qrdec®| s
oh]_cyie ("HESaakTodl Less®, " 111300%) ) 1
List_seleot_item |*FLly From *, "Demwer™ip @ Iteam Mumbec O il User toolbar
List_select item |"Fly To:", "San Frenci=co™|; @ Iien Number B» =

nb]_muu_:].ick ("FLIGHT", L&, 1d&, LEFT|:

Status bar

| 7-1 WinRunner 1% [

3. WRAEH

WA A W 7-2 fros, EMRRE DR RPAT IR & RS LR

a). Test Window title bar PR FIARARS, o 41T T it 44 4K

b). Test script WK JHIA, ik s il g 5 A0S 77 A

c). Execution arrow AT 87 Sk, 884 HTIELERAT I —ATIIAS, 40 SRARZERE B X AR & B AT,
TG BAEAZAT 2o 11 A rt BUb o

d). Insertion point 4 A A, 32 H VR AT LA AN B G SCAR )



E CADANT & 1"

ore=r window |YF2iphi Rusarvatice®, 11): Tast windew !itls bar
ch)_type (“MSNeakBndCleas®, *0237257) |
Liav_seleac_item ("Fly Foams ™ "Framkfuct™)) & Item Mmber I:
ligt_select icam (MFly Tor®, Tomden™? & Itax Nuphap 1»
cby mowae click |®sd7id% 114, ZD&, LEFT|: E:El:'i'ﬂl'm amow

oh) moupe click | *FLIONT®, 4%, 10, LEFT):

2t vindow | FFlighda Teblda®, 117

List_eonivere_ivewm ("Flight™, "1M556 PFRA  I0:2d AW Low 22 . .
set_window |TE)iget Resarratice”, T): Insertion pcnnf
sdit_met ("Namai®, SToks Sadch®) ¢

button press |*Insart Opcez*);

oh)_obeok_ymi |*Znsact ledac® Plastl.ckl®: Pguai® 190

Tast soript

ob)_okeok bicwap | *Inaast Doza...% *Inglv, 5|7

K 7-2 Dk
4. B WinRunner #f4
7E WinRunner J3 2, A LAESE 2 ActiveX control . PowerBuilder. VisualBasic 5% WebTest {1
o FLABSR AT ZE A ML ARG TS, SONZERINEN A A, A LB A T B8 230 sk il Bk
PATHIL I 8. 3 Show on startup A IfT /A 2345, JX A~ Add— In Manager [ % 1S 2575 WR i
g I Rt ) DAEREN WR 5 7 Settings>General Options>Enviroment FL 15 & 15 (8 JF-4f
SR IXAN T 1A R S5 I [A] 45

= HIEA

B N oK ARZ LA Context Sensitive #Esil— Bl A, MK A i) 0 iR R 0 7
RightReservation JF )i —2%1] Hi.

1. JFJ8 WinRunner F1#k GUI Map File $47 LJT461->0#2 54 1->[ WinRunner 1->[ WinRunner ],
R — AT WinRunner, <3P R XGEE H, ik [New Test): Wi BcAT F R I e 1, W)
i% [Fle] -> [New].

Ki £ GUI Map File &5 L& N2k, »iik [Tools] -> [GUI Map Editor] JF )i GUI MapEditor, i A5
1% [View] ->[GUI Files] # & J& &5k flight4agui. 1R flightdagui % gk, ik [Flel->[Openl

SRIG RN flightdagui J5, 3% F [Open] ¥R

2. JFJ3 Flight Reservation -8 A$AT LT 44 1-> LR 4] -> [ WinRunner ] -> [ Sample Applications]
-> [Right 4A), BAG N2 HFE. 74 [Agent Namel A% 5, 2/ FEE, [ Password] i A
mercury, % T [OK] 4&41% A Flight Reservation.

P4 WinRunner 5 Fight Reservation % /NS0 &, ik —ANE 1A AT AT 2& 185 ..

3. FFUELL Context Sensitive #5235 il A<

{F WinRunner 153k [ Test] -> [ Record — Context Sensitive) % & B 32 55 ik T 241 1) @ Record %
H1. W T WinRuner 2 U4 BURRI £ LU BEAL A it ey
M W (1) Rec 2 BLZE 4 7, BLee L4\ Context Sensitive st T 7

WinRunner 77 PRSI FIFE AT, FoRBE QA A BN A T
4. JF)3 3 FiTH4E Flight Reservation H 5%k [File] -> [Open Order], 7 Open Order %I+ %



it [OrderNo.] JFH#iA 3 J53% F [OK],
5. fF1bs
6. fEAE IR A
=. PUTHZE
MRE N TR 2 )5, IR C ZHE & L HAT I A 3120 B R 45 I T . WinRunner $2£ —F
PATIAR A0 Verify, Debug. Update.
Verify: YR EIE AT IR IS 2 N R AF I ShRE,  IF HE g A7k 6 R .
Debug: MARAEL A MR AR PAT L NG, B R
Update: % {/R 22 5 A 23 s I TR I
PAT:
1. ffiih WinRunner 5 Flight Reservation ) % I#E 4T )0
2. FFJ3 loeesond YR HA
Stk [File] -> [Open] JT )3 lessond st HIA .
3. i Flight Reservation 7 3% 1
WURAT FEONE & 11 26 K A
o AT R L G R e
5. &ii£ Run From Top
Rk [Test] -> [Run From Top] =& H4% 5% T 21 L)
@I, 7% F [LOKY JFEEATIAR .
6. i Test Run Name
& A\ Test Run Name, WinRunner 244 R BAT 145 Rt /£ #ETest Run Name [H H X T,
Wireslo 1 bR EE Bk 2 i AF AEMR A H 3 F
THTER 1R J7 [ Display test results at end of runl, #/2) GEIE IR, W4 MR IAIAT 52 B ),
WinRunner & B30 G MRAHAT S5 R A6 M. 152N,
7. AT
1% F [OK] JG WinRunner £ i AT IR A o
T E W% WinRunner A4 $i AT IR A o
8. R HIT R
LRI T5E e, WinRunner 43T ) Test Results % 11, B AT 145 R
ENESY|
1 RESHRY, FEIHGARN EHLECE AN A2
2. PRAT A A

L L, 1441, MRun Test
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[l B /Y]
IV H] Web B3 T 56 Web S EEEAT L Be A1 BE
[S:ill /2]
Xt Web AT ZMIIRE. PERE. ATHITE. 22 4xMEas 207 i sEAT it

s DhREINA

X Web 24813547 Dy M A4S LR JLANJ7 1 -

1. SN

FERE Web N RGEH) — A L, B AR DU (A DI AR T ] 25— S8 ANKniE s bk A 5T
M EEEF B ST 2o = A5 158, WRKPT A B L 1357 1 SREf S B 3 7 i Bk
AT s L, MU R 0 DU R A7 A e, DRIE Web W HI RS BB ILH T, Frif sz
LIRS Fi7 AT BERE AR 17 1% DL T

2. REBJRA

MY Web B RGBT IRAS AR I, b R BT R A, B e, B AR
PEATEE o AEXFPHOL R, AT NS AT AR (1 56 Bk, DA A 45 IR 55 4 1R A5 L IR IE A v o 43l -
M PSR A H SIS Y, HSH TR A0 5 P el 2 R IUCE S . R AH T EIME, &
BRI ER VB A E A o 0 SRR B BE R 1 A LA, U AT I i dn . L BE R L AT
DA A DB IX S 15, B RS SR A

3. Cookies J,

Cookies it ¥ HIAA7 it H P A5 AT P RN RS HERAE, 49— Nl Cookies 1] 73—
NN H RGN, Web k453545 A 0E T H P IAE B, HEi%E L Cookies [1W7E XAFififE & il 55
BUE, IXRT RN 8 A F0 B 5@ SCITTH B A S B 4545 S

WR Web NV RG] T Cookies , miAbZiifi A Cookies s 117 fg iFH TAE. Ml N A T 46
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